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Getting Started 
Intended Audience 
This manual is intended for IT administrators in 
their use of Reveal or anyone wanting to learn 
more about Reveal. It includes installation 
instructions and feature descriptions. 

Technical Support 
If you have a technical support question, please 
consult the GWAVA Technical Support section of 
our website at www.gwava.com. 

Sales 
To contact a Beginfinite sales team member, 
please e-mail info@gwava.com or call Tel: 866-
GO-GWAVA (866-464-9282) in North America or 
+1 514 639 4850. 

Suite 500, 100 Alexis Nihon Blvd., Montreal, 
Quebec, H4M 2P1, Canada. 

About Reveal 
Reveal is an  e-mail auditing solution for Novell 
GroupWise® that provides a quick, safe and 
immediate access to a company’s GroupWise® 
system so executives can review e-mail use for 
best practices and security.  

Copyright Notices 
The content of this manual is for informational 
use only and may change without notice. 
Beginfinite Inc. assumes no responsibility or 
liability for any errors or inaccuracies that may 
appear in this documentation. GroupWise is a 
registered trademark of Novell, and copyrighted 
by Novell. Windows is copyrighted by Microsoft. 
© 2005 Beginfinite Inc. All rights reserved. ® 
GWAVA is a registered trademark.  
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Introduction 
Reveal allows authorized users to review the contents of any employee' mailbox, search for messages 
based on key words or content and retrieve these messages from GroupWise while maintaining the 
security of the system and leaving no hint to the mailbox owner that their e-mail accounts have been 
inspected for policy compliance. Reveal provides protection from information leaks, misuse of companye-
mail, and legal liability. Reveal ensures that executives are able to accurately evaluate e-mail activity so 
they can properly enforce policy and procedure. 

Product Overview 
Reveal shows the executive any employee’s live mailbox without the need for IT staff assistance. 
Authorized executives to review the contents of any employee’s mail box, search for messages based on 
key words or content and retrieve these messages from GroupWise.  

Live Confidential e-mail Inspection 
For legal, human resources and compliance auditors, Reveal provides the ability to maintain oversight to 
all e-mail communications within Novell GroupWise. Reveal monitors and scans all e-mail. This provides 
protection from information leaks, misuse of company e-mail, and legal liability. Executives can view live 
mailbox activity of individual users, and easily monitor company-wide e-mail communication. 

Confidential e-mail investigations 
Reveal show authorized users the exact same mailbox that the user sees without any modification by an 
outside source.  

Retrieve e-mail for evidentiary review 
Reveal can export e-mail into a wide range of formats for evidentiary review and assessment by your legal 
team including HTML, CSV, XLS and DOC. 

Licensing 
Reveal is licensed per user. Reveal will operate as a demo for thirty days for testing purposes. Once the 
demo period elapses, you must purchase a license for the appropriate number of users on your system.  

 
 

Features 
� 
� 
� 
� 
� 
� 

� 

� 

� 
� 

� 

� 
� 

� 

� 

� 
� 

� 

Confidential e-mail Inspection 

Mailbox content review 

Designed for auditors and legal staff 

Search employee mail 

Print and export employee e-mail 

Confidential process - No modifications are 
made to the mailbox 

Complete logging for review of auditing 
activities 

Supports full search capabilities of 
GroupWise 

View employee proxy settings 

View, export, and print employee address 
book 

View, export, and print employee calendar
 

 

Minimum System Requirements
GroupWise 6.5 with Support Pack 1 or better 

Reveal must be configured as a Trusted 
Application within GroupWise 

Desktop System: Windows XP or 2000 with 
GroupWise Windows Client v6.5.1 or later 

256 mb RAM 

10 mb hard drive space 

To export into Excel or Word Exporting, those 
Microsoft products must be installed 

Network access to your GroupWise system
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Installing Reveal 
Reveal installs on your Windows XP 
desktop with GroupWise 6.5 SP1 Windows 
Client installed connecting to a GroupWise 
6.5 SP1 e-mail system. You do not need to 
be running GWAVA or any other Beginfinite 
products to be a Reveal administrator. 

Download Reveal from www.gwava.com 

Launch the Reveal set up executable. The 
first screen is informational: click Next to 
begin. The executable runs a script to 
ensure its install wizard is configured 
correctly. Click Next twice. 

 

 

 

 

 

 

 

 

 

License 
Reveal is commercial software and licenses 
for its operation must be purchased from 
GWAVA. Please read the license agreement 
and click to agree to the terms to 
continue. Click Next when ready. 

Clicking Back or Cancel will leave your 
computer unchanged.
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Destination Folder 
The next screen is used to select where on your 
workstation Reveal will be installed. The default 
location is c:\program files\beginfinite\gwava 
reveal; however another location can be chosen. 
Regardless, a shortcut to Reveal will be placed on 
your desktop 

Clicking Back or Cancel will leave your computer 
unchanged. 

 

 

 

 

 

 

 

 

The Install Wizard is now ready to create your 
Reveal folder. Click Install to place a copy of the 
Reveal software on your workstation. Clicking 
Back or Cancel will leave your computer 
unchanged. 

 

 

 

 

 

 

 

 

 

 

The wizard will install Reveal. Click Finish to close 
the installer. You can also enable the Launch 
GWAVA Reveal checkbox to launch the software 
immediately. 

 

 

What’s Next? 
The software has been installed, but now it needs 
to be configured. This is merely a matter of 
letting Reveal know where your GroupWise mail 
system keeps its files.

Copyright 2005 Beginfinite Inc. 
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Configuring Reveal 
The first time Reveal is run it prompts users to generate a Trusted Application Key to gain access to the 
database.  

Reveal determines whether a key is present. If a key is 
not, one is generated automatically. Click the Execute 
menu on the Reveal interface. Select Connect to 
GroupWise system. A screen will be presented asking 
you to identify the path your primary domain directory. 
Click the Browse button and navigate to the required 
location.  

 
 

Upgrading from a previous version 
The Reveal Installer also contains an updater for 
upgrading older versions of Reveal. 

� 

� 

� 

Launch the installer. If the installer has a version of 
Reveal that is newer than is installed, a dialogue box 
will be presented asking whether an upgrade should be 
applied. Click Yes to continue. 

Click Next to apply the update and Finish when 
complete. 

The Installer also has the ability to modify an 
installation by selectively applying new features. Run 
the installer. Select Modify. Select the specific features 
required, then click Next and Install. 
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Using Reveal 
From this elegant interface, executives can examine their users’ mailboxes instantly.  

 

 

Starting Reveal 
Double-click the Reveal icon that was created on your desktop during the installation process or launch 
the program using the Start Menu. 

 

 

 

 

Stopping Reveal 
Select Close from the File menu. 

 
 



Reveal 

Copyright 2005 Beginfinite Inc. 

9 

The Menu system 
� 

� 

� 

� 

� 

File 
o Close  

Execute  
o Connect to GW system 
o Search Messages 

Settings  
o Languages 

� English 
� Dutch 

o Create LogFile  

Administrator 
o Change Password 
o (Re)Create Trusted Application Profile 

Help 
o About GWAVA Reveal 
o GWAVA Reveal on the web (links to GWAVA.Com) 
o Registration (Enter license) 
o About 

 

Create Log File 
The debuglog.txt file is useful in diagnosing Reveal’s behavior 
and improving performance. It is stored in the Reveal program 
directory. 

(Re)Create Trusted Application Key 
The creation of a new security key for connecting to your 
GroupWise database may be required on occasion. Note  - 
Selecting this option may require that you wait one or more 
minutes before the key enters operation. 

About 
This informational screen presents information about your 
Reveal installation. It is useful for determining which build 
version is in use and other general debugging requirements. 
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Connecting for the first time 
Connecting for the first time successfully involves nothing more complicated than pointing Reveal at the 
database where GroupWise mail is stored on your network.  

 

You can tell whether Reveal is connected to your network by the status 
indicator at the bottom left hand corner of the interface. Click the Connect to 
GW system icon to begin. 
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Locate DB 
A dialogue box will be presented. Navigate to the GroupWise database. To license your copy of Reveal, 
write access is needed to the Domain Directory of your GroupWise system.  

 

Locate the file called wpdomain.db. Select it. 

Default Password 
You will be asked for your 
case-sensitive Reveal 
password. For new 
installations, your default 
administrator password is 
gwava.  

Reveal will ask whether to 
present a view of your 
GroupWise system that is 
read from the cache, or 
should it read from the 
live system. For your first run, select the live database since you have no previous session to view. The 
cache mechanism is for performance improvement only. 

This completes the installation and first run requirements. The network—and users in it—will now appear 
in the left-hand pane. You can now use Reveal.
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Request a License 
To register for a license, select the Registration 
option from the Help menu.  

This presents a form with the fields GroupWise 
System Name, Contact Person, E-Mail address, 
Company Name, Address, City State, Zip Code, 
Country, Phone and Fax. 

Click Request when the form is 
complete or Close if you do not wish to 
complete this form. Clicking Request 
generates an e-mail with your default 
e-mail program to be sent to GWAVA 
licensing. Click Send. 

� The only information in this e-mail 
is the data needed to generate a 
personalized Reveal license 

Enter your license 
GWAVA will reply by sending a two-part 
combination. There is a License Key and 
a License Code. You must enter both 
pieces of information correctly. Invalid 
keys and codes or fields left blank will 
cause Reveal to remain in Demo or By-
Pass mode. 

 

 



Reveal 

Copyright 2005 Beginfinite Inc. 

13 

Finding Users 

  

 

To examine a specific user’s mail account, select the 
user from the list of accounts. To locate a user, use 
the Find a user field. Enter a name and click the Find 
button.  Note - the Find field only locates users from 
the list, it does not search for content. 

 

 

 

Contacts and Calendars 
Once Reveal connects to a 
user mail box, access is 
gained to that user’s 
address book and calendar 
data.
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Searching Messages 
The Search messages button presents the content searching tools window. From this 
screen, administrators can search for any content, attachment or element of any e-
mail. 

� 
� 
� 
� 
� 

� 
� 
� 
� 
� 

Run, load and save searches 

Users 

Subject 

Message text 

Any field (any key words in any location) 

Sender 

Recipients 

Attachments  

Size 

Date Range
 

 

After a connection to the network has been established, load a search by clicking the Search Messages 
button. Click the Open Search Criteria button. Select the default search: Search criteria empty – this 
returns all e-mail for your selected users.  

 

After this point, you can drill down to more granular levels by 
specifying message characteristics, keywords and attachments.  

Click on a mail message to read or export. Note that for any 
message attachments, the attachments still require their 
programs. For example, to read a Microsoft Word document that 
was attached to a mail message, you must have word installed. 

The column titles are clickable and can be used to sort your 
messages. The directional triangle indicates the sorting 
direction of the active column. 
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Open Search Criteria 
This feature lets Reveal administrators save often used searches. 
Reveal has several default searches installed as examples. 

 

The Open Search Criteria button presents a new window with 
search scripts for your selection. The default example searches are: 

� 
� 
� 
� 

� 

Default – Empty (any search criteria) 

Date Range –1-5-2005 and 1-10-2005 

Too Big – All mail larger than 2 mb 

Unwanted attachments – All mail with non business-related 
attachments like mp3 and avi 

Unwanted senders – All mail from unwanted senders that have 
attachments 
 

 

 

Click the Execute button to run the search 

 

 

 

 

 

The last search can be saved by clicking the Save 
search criteria button.  

You will be asked to name the search, and 
provide a description. Click OK once the 
description has been entered. Please use a plain 
text description that will be easy to understand 
in the future. 

Clicking Search now will show your saved search 
in the list of available actions. 

Note - Searches are stored in the GWAVA 
Reveal/Searches directory and can be edited 
with by the more technically-minded directly.  

 

 

Adding search criteria 
The Add to existing criteria if possible checkbox allows complex searches to be built quickly. It adds the 
characteristics of the selected search to your existing search.  

Copyright 2005 Beginfinite Inc. 
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Exporting Search Results 
To save a specific mail, or a range of mails, right click the results window. This presents a drop-down 
menu with the following options: 

� 
� 
� 
� 

� 
� 

Open Message 

Save Message(s) 

Forward Message(s) 

Export message list 
o As HTML document 
o As SCV document 
o As MS-Excel Document 

Save Result List 

Open Result List 
 

 

 

Result Lists 
Results can be saved by right-clicking. Note that a range of 
messages can be selected. Previously saved result list can also 
be opened. 
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Users 
To search the mailboxes of specific accounts, click the Users tab. 
Then select the user or users to be included in your search.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Subject 
To search the mailboxes for mail using specific subjects, click the 
Subjects tab. Then select the user or users to be included in your 
search. 

� Using the Any keyword function returns the broadest range of 
results 

 
Using the Keyword(s) in list feature by selecting words from the 
list presented to narrow a search. 
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Message Text 
To search for mail using specific text strings, click the Messages 
text tab. Then select the user or users to be included in your 
search. 

� 

� 

� 

� 

Using the Any keyword function returns the broadest range of 
results 

Using the Keyword(s) in list feature by selecting words from the 
list presented to narrow a search 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Any Field 
To search all fields in mail messages—not merely subject lines, 
to and from headers—select the Any Field tab.  

Using the Any keyword function returns the broadest range of 
results 

Using the Keyword(s) in list feature by selecting words from the 
list presented to narrow a search 
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Sender and Recipients 
To search for keywords in mail sent by users on your 
network, click the Sender tab. To search for mail recipients 
of mail with certain keywords, click the Recipients tab. 

� 

� 

� 

� 

Using the Any keyword function returns the broadest range 
of results 

Using the Keyword(s) in list feature by selecting words from 
the list presented to narrow a search 

 

 
 
 
 
 
 
 
 
 

Attachments 
Click the Attachments tab to search for documents and files 
appended to e-mails in your system. There are two options for 
helping narrow your searches for attachments: 

Message MUST contain an attachment - This returns all mail 
with attachments 

Attachment type in list (Select the attachment type required 
for your search.) This narrows search results

Copyright 2005 Beginfinite Inc. 
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Size 
To search the mailboxes for e-mails based upon the size, click the 
Size tab. There are four options for helping narrow your searches for 
attachments: 

� 
� 
� 
� 
� 

Size doesn’t matter (the default) 

Small (Less than 5 k) 

Average (5kb-500kb) 

Larger (Larger than 500kb 

Custom size (insert operator with value) 
 

 

 

 

 

 

 

 

 

 

 

 

 

Date Range 
Reveal allows administrators to search 
for messages by date.  

The default is to report all messages 
(the date doesn’t matter option). To 
narrow a search to within a date r
click on the calendar to choose a Start 
Date and an End Date.  

ange, 

rs.  
The greater left and right arrows can be used to navigate months 
and yea
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Appendix 1: Troubleshooting 
There are only a few reasons Reveal may have issues during operation. 

� 

� 
� 
� 
� 

You are not able to connect to the GroupWise system – Ensure that your Reveal installation has access to the 
wpdomain.db 

You are not using a GroupWise Client v6.5.1 or later 

You are not currently logged into GroupWise during operation of Reveal 

Your Trusted Application Key is invalid and must be recreated 

User mailboxes are disabled 

GroupWise version 
Ensure your GroupWise client—the mail program 
installed on your PC—is at least GroupWise 6.5.1 
or later. To check, launch your GroupWise client.  

Select About GroupWise from the Help menu.  

Note the Program Release field in the pop-up 
window. It must say ‘GroupWise 6.5’ or later. 

Click OK when done. 

 

 
 

 
 

 

If you cannot connect to users’ mailboxes 
User accounts are no longer enabled. Ensure 
Reveal is operating in on-line mode and not 
caching mode to ensure that the user list is 
up to date. Also check that you are logged 
into a GroupWise mailbox of a GroupWise 
system with which Reveal is to be used. 
 

 

 

Tip! - Create Log File 
Enable log file creation from the Settings Menu. The Log file 
is useful in debugging Reveal’s behavior and can be found in 
the Reveal program directory with the name 
debgugginglog.txt. 

 

 

Re-run the installer 

The Reveal installer has a built-in repair function. Launch 
the installer, click the Repair button, Next and then Install. 
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Appendix 2: Uninstalling Reveal 
Removing Reveal is a straightforward, 
entirely automated process.  

Launch the Reveal set up executable. 
Click the Remove radio button. Then, 
click Next. 

 

 

 

 

 

 

 

 

 

 

 

You will be asked to confirm the 
removal. If you wish to proceed, click 
Remove. If not, click Cancel to leave 
your Reveal installation untouched.  

 

The installer will then remove the 
program from your computer. Once this 
has been accomplished, click Finish.
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Appendix 3: Search Scripts 
Below is an example of the search criterion script for non-business-related attachments. Saved scripts are 
in the BeginFinite/GWAVA Reveal/Scripts directory. Here is what a sample script looks like in its raw 
form. 

[Description] 
SearchDescription=All mail with unwanted attachments like mp3, avi, etc. 
 
[Subject] 
Any keyword=1 
Selected subjects=0 
 
[MessageText] 
Any keyword=1 
Selected MessageTexts=0 
 
[Any field] 
Any keyword=1 
Selected AnyFields=0 
 
[Sender] 
Any keyword=1 
Selected Senders=0 
 
[Recipients] 
Any keyword=1 
Selected Recipients=0 
 
[Attachments] 
MustHaveAttachment=1 
Selected Attachments=1 
Item0=avi 
Item1=mov 
Item2=mp3 
Item3=mpeg 
Item4=mpg 
Item5=ogg 
Item6=swf 
Item7=vqf 
Item8=wav 
 
[Size] 
AllSizes=1 
Small=0 
Average=0 
Large=0 
Custom=0 
CustomValue=2000 
 
[Date] 
AllDates=1 
Selected dates=0 
StartDate=<not set> 
EndDate=<not set> 
 

Remember! 
Remember to change the Reveal password from 
its default “gwava”. 
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Contact Reveal 
For all of your support and purchasing needs, please visit our home page at www.gwava.com. 

100 Alexis Nihon, Suite 500 
Montreal, QC, H4M 2P1, Canada. 
E-Mail: info@gwava.com 

 

http://www.groupwisesolutions.com/
mailto:info@gwava.com
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